
Aula 24 3 Automação com GREP e Scripts
Você já se sentiu preso em um ciclo interminável de tarefas repetitivas, como ajustar o formato de milhares de 
números de telefone, aplicar o mesmo estilo a centenas de e-mails ou corrigir espaços duplos em um documento 
gigantesco? Se a resposta é sim, saiba que você não está sozinho. A rotina de um designer editorial, por mais 
criativa que seja, muitas vezes esbarra em processos manuais que consomem um tempo precioso e abrem portas 
para erros. Mas e se eu dissesse que existe uma forma de libertar-se dessas amarras e focar no que realmente 
importa: a criatividade e a estratégia do design?

Nesta aula, embarcaremos em uma jornada para desmistificar a automação no design editorial, explorando duas 
ferramentas poderosas do Adobe InDesign: o GREP (Global Regular Expression Print) e os Scripts. Nosso objetivo 
é que, ao final deste encontro, você seja capaz de identificar oportunidades de automação em seus projetos, 
utilizar expressões GREP para buscar e substituir padrões de texto complexos, e entender como os Scripts podem 
transformar tarefas repetitivas em ações de um clique. Prepare-se para otimizar seu fluxo de trabalho, aumentar 
sua produtividade e elevar a qualidade dos seus projetos, seja para cumprir horas complementares na 
universidade ou para se destacar em um concurso público.

A automação não é apenas uma conveniência; é uma necessidade no cenário atual do design editorial. Com a 
crescente demanda por projetos que funcionam tanto em mídias impressas quanto digitais (e-books, revistas 
digitais, PDFs interativos), a adaptabilidade e a consistência do layout tornam-se cruciais. Dominar essas 
ferramentas significa estar à frente, preparado para os desafios de um mercado que valoriza cada vez mais a 
eficiência e a inovação. Vamos juntos descobrir como a tecnologia pode ser sua maior aliada.



O Desafio da Repetição: Por Que Precisamos 
de Automação?
Imagine-se na cozinha, preparando um jantar especial. Se você precisa cortar centenas de legumes em cubos 
perfeitos, um por um, a tarefa se torna exaustiva e demorada. Agora, pense em um processador de alimentos: ele 
faz o trabalho em segundos, com precisão e sem cansar. No design editorial, muitas vezes nos encontramos na 
situação de cortar legumes manualmente, ou seja, realizando tarefas repetitivas que, embora necessárias, drenam 
nossa energia e tempo.

Problemas da Repetição Manual
Diminui a produtividade

Aumenta chances de erro

Consome tempo precioso

Afasta do foco criativo

Benefícios da Automação
Velocidade na execução

Precisão consistente

Liberdade para criar

Foco na estratégia

A realidade é que, em projetos grandes ou com prazos apertados, a repetição é um inimigo silencioso. Seja 
formatar títulos, ajustar espaçamentos, aplicar estilos de caractere a termos específicos ou até mesmo exportar 
dezenas de arquivos em diferentes formatos, cada clique manual é um segundo perdido, cada ajuste repetido é 
uma chance de erro. Essa rotina não só diminui nossa produtividade, mas também nos afasta do foco principal: a 
criatividade e a estratégia por trás do design.

Dica Importante: A automação é a ponte entre o trabalho árduo e o trabalho inteligente. Ela não substitui o 
designer, mas potencializa suas habilidades.



GREP: O Detetive de Padrões no InDesign
Você já precisou encontrar algo muito específico em um texto, mas as ferramentas de busca e substituição 
comuns não eram suficientes? Talvez você quisesse encontrar todos os números de telefone, independentemente 
do formato, ou todas as palavras que começam com uma letra maiúscula e terminam com um número. Nesses 
casos, a busca tradicional é como procurar uma agulha no palheiro com os olhos vendados.

O que é GREP?
Global Regular Expression 
Print - uma linguagem 
poderosa para descrever e 
encontrar padrões de texto, 
não apenas palavras exatas.

Como Funciona?
Atua como uma lupa 
superinteligente que não só 
encontra a agulha, mas 
também descreve o material, o 
tamanho e a forma dela.

Integração no InDesign
Está integrado à função 
"Localizar/Alterar" 
(Find/Change), permitindo 
padrões complexos para 
buscar e substituir.

É aqui que o GREP entra em cena, atuando como um verdadeiro detetive particular dentro do InDesign. O acrônimo 
GREP vem de "Global Regular Expression Print" e, em termos simples, é uma linguagem poderosa para descrever e 
encontrar padrões de texto, não apenas palavras exatas. Pense nele como uma lupa superinteligente que não só 
encontra a agulha, mas também descreve o material, o tamanho e a forma dela, mesmo que ela esteja escondida 
em um monte de palha.

No InDesign, o GREP está integrado à função "Localizar/Alterar" (Find/Change), permitindo que você defina 
padrões complexos para buscar e, se desejar, substituir por outros padrões ou aplicar estilos. Ele não se limita a 
caracteres literais; ele entende "qualquer dígito", "qualquer letra", "qualquer espaço", "qualquer coisa que se repita 
X vezes". Essa capacidade de reconhecer estruturas e não apenas conteúdos fixos é o que o torna uma ferramenta 
indispensável para a limpeza, formatação e organização de textos em projetos editoriais de qualquer porte.



A Linguagem Secreta do GREP: 
Metacaracteres Essenciais
Para se comunicar com o detetive GREP, precisamos aprender sua linguagem. Não se preocupe, não é um novo 
idioma completo, mas sim um conjunto de símbolos especiais, chamados metacaracteres, que representam 
categorias de caracteres ou regras de repetição. É como aprender algumas frases-chave para dar instruções 
precisas ao seu assistente. Sem eles, o GREP seria apenas uma busca comum; com eles, ele se torna um super-
herói da edição de texto.

Esses metacaracteres nos permitem construir expressões que descrevem o que estamos procurando, em vez de 
apenas digitar o que queremos encontrar. Por exemplo, se você quer encontrar qualquer dígito, não precisa digitar 
"0", "1", "2" e assim por diante. Basta usar o metacaractere que representa "qualquer dígito". Essa abstração é a 
chave para a flexibilidade e o poder do GREP, permitindo que você lide com variações e inconsistências no texto.

Vamos conhecer alguns dos metacaracteres mais fundamentais que abrirão um mundo de possibilidades para 
suas buscas e substituições. Dominar esses poucos símbolos já fará uma diferença enorme na sua capacidade de 
manipular texto de forma eficiente e precisa. Eles são os blocos de construção para qualquer expressão GREP 
mais complexa que você venha a criar.

Metacaract
ere

Significado/Função Exemplo de Uso O que Encontra

. Qualquer caractere (exceto quebra 
de linha)

a.b "acb", "a b", "a-b"

\\d Qualquer dígito (0-9) \\d\\d\\d "123", "456"

\\s Qualquer caractere de espaço em 
branco

palavra\\spalavra "palavra palavra"

* Zero ou mais ocorrências do 
caractere anterior

a*b "b", "ab", "aab", "aaab"

+ Uma ou mais ocorrências do 
caractere anterior

a+b "ab", "aab", "aaab" (não 
encontra "b")

? Zero ou uma ocorrência do 
caractere anterior

colou?r "color", "colour"

[] Conjunto de caracteres (qualquer 
um dentro dos colchetes)

[aeiou] Qualquer vogal

[^] Conjunto de caracteres negado 
(qualquer um _exceto_ os dentro 
dos colchetes)

[^0-9] Qualquer caractere que 
não seja um dígito

{n} Exatamente n ocorrências do 
caractere anterior

\\d{3} Exatamente 3 dígitos 
(ex: "123")

{n,m} Entre n e m ocorrências do 
caractere anterior

\\d{2,4} 2, 3 ou 4 dígitos (ex: 
"12", "123", "1234")



GREP na Prática: Formatando Números de 
Telefone
Um dos desafios mais comuns no design editorial é a inconsistência na formatação de dados, como números de 
telefone. Você já recebeu um texto onde os telefones apareciam como 11987654321, (11) 9876-5432, 11 98765432, 
ou até 987654321 sem DDD? Padronizar isso manualmente em um documento longo é uma tarefa hercúlea e 
extremamente propensa a erros.

01

Identificar o Problema
Telefones em formatos inconsistentes: 11987654321, (11) 
9876-5432, 11 98765432

02

Definir o Padrão Desejado
Formato único e profissional: (11) 98765-4321

03

Criar a Expressão GREP
Usar grupos de captura para "lembrar" as partes do 
número

04

Aplicar a Substituição
Referenciar os grupos capturados na substituição

Com o GREP, essa tarefa se transforma em uma questão de segundos. Podemos criar uma expressão que 
"entenda" todas essas variações e as reformate para um padrão único e profissional, como (DDD) 9XXXX-XXXX. É 
como ter um assistente que não só encontra todos os telefones, mas também os reescreve perfeitamente, 
garantindo consistência visual e legibilidade, um ponto crucial para a acessibilidade do seu material.

Expressão GREP Completa

Localizar: \\(?(\\d{2})\\)?\\s?(\\d{4,5})\\-?(\\d{4})

Alterar para: ($1) $2-$3

Esta expressão captura DDD, primeira parte e última parte do número, reorganizando-os no formato 
padrão.

Vamos construir uma expressão GREP para encontrar números de telefone no formato brasileiro e padronizá-los. 
Nosso objetivo é transformar algo como 11987654321 ou (11) 9876-5432 em (11) 98765-4321. A chave aqui é usar 
os grupos de captura () para "lembrar" as partes do número (DDD, primeiros dígitos, últimos dígitos) e depois 
referenciá-los na substituição.

Explicação da Expressão:

\\(? e \\)?: Encontra um parêntese de abertura ou fechamento opcional

(\\d{2}): Captura exatamente dois dígitos (o DDD)

\\s?: Encontra um espaço opcional

(\\d{4,5}): Captura 4 ou 5 dígitos (primeira parte do número)

\\-?: Encontra um hífen opcional

(\\d{4}): Captura exatamente 4 dígitos (última parte do número)

Ao aplicar essa regra no painel "Localizar/Alterar" do InDesign, você verá a mágica acontecer: todos os números 
de telefone serão formatados de maneira uniforme, economizando horas de trabalho e garantindo um resultado 
impecável.



GREP na Prática: Limpeza e Organização de 
Texto
Textos importados de diferentes fontes, como documentos do Word, e-mails ou páginas da web, frequentemente 
vêm com uma série de "sujeiras" invisíveis: espaços duplos, quebras de linha extras, tabulações inconsistentes. 
Essas pequenas imperfeições podem comprometer a estética do seu design e dificultar a diagramação, exigindo 
um trabalho manual exaustivo para correção.

Pense no GREP como um faxineiro digital super eficiente. Ele não apenas varre a sujeira visível, mas também 
aquela que está escondida, garantindo que seu texto esteja impecável antes mesmo de você começar a aplicar 
estilos mais complexos. Essa etapa de limpeza é fundamental para a qualidade final do seu projeto e para a 
consistência em todas as plataformas, do impresso ao PDF interativo.

Problema: Espaços Duplos
Localizar: \\s\\s+

Alterar para: \\s

Remove dois ou mais espaços consecutivos, 
substituindo por um único espaço.

Problema: Quebras Duplas
Localizar: \\r\\r+

Alterar para: \\r

Remove quebras de parágrafo extras, compactando 
parágrafos vazios.

Vamos ver como o GREP pode nos ajudar a resolver dois problemas clássicos de "sujeira" textual:

Remover Espaços Duplos: É comum encontrar dois ou mais espaços entre palavras. Isso pode causar 
problemas de justificação e espaçamento.

1.

Localizar: \\s\\s+ (encontra dois ou mais espaços em branco consecutivos)

Alterar para: \\s (substitui por um único espaço em branco)

Explicação: \\s representa qualquer caractere de espaço em branco. O \\s+ significa "um ou mais espaços". 
Combinando \\s\\s+, garantimos que estamos pegando pelo menos dois espaços.

Remover Quebras de Linha Duplas ou Inconsistentes: Textos colados podem vir com quebras de parágrafo 
extras ou quebras de linha forçadas que não são ideais para a diagramação.

2.

Localizar: \\r\\r+ (encontra duas ou mais quebras de parágrafo consecutivas)

Alterar para: \\r (substitui por uma única quebra de parágrafo)

Explicação: \\r representa uma quebra de parágrafo. Essa expressão é útil para compactar parágrafos 
vazios. Para quebras de linha forçadas (Shift+Enter), o caractere é \\n.

Dica Profissional: Essas simples expressões GREP podem economizar horas de trabalho manual de 
revisão e correção, garantindo que seu texto esteja limpo e pronto para receber a formatação final.



GREP e Estilos de Caractere: Dando Vida ao 
Texto
O poder do GREP não se limita a encontrar e substituir texto. Ele brilha ainda mais quando combinado com os 
Estilos de Caractere do InDesign. Imagine a situação: você tem um manual técnico e precisa que todos os termos-
chave, como "interface do usuário" ou "algoritmo de criptografia", apareçam em negrito. Ou, em um livro de 
biologia, todos os nomes científicos (em latim) precisam estar em itálico. Fazer isso manualmente, termo por termo, 
é uma tarefa monumental e entediante.

GREP Encontra
Identifica padrões específicos no 
texto automaticamente

Estilo Aplica
Formata visualmente os 
elementos encontrados

Resultado Final
Consistência visual perfeita em 
todo o documento

A integração do GREP com Estilos de Caractere permite que você não apenas encontre esses padrões, mas 
também aplique um estilo visual específico a eles de forma automática. É como ter um pintor que, ao invés de 
pintar cada detalhe à mão, consegue identificar todos os elementos de uma cor específica e aplicar um novo tom a 
eles instantaneamente. Isso garante não só a velocidade, mas também uma consistência visual impecável em todo 
o documento, essencial para a identidade visual e a legibilidade.

Vamos usar um exemplo prático: aplicar um estilo de caractere a todos os endereços de e-mail em um texto.

Crie um Estilo de Caractere: No painel "Estilos de Caractere" (Type > Character Styles), crie um novo estilo 
chamado "Email Link". Defina as propriedades que desejar, como cor azul, sublinhado ou uma fonte diferente.

1.

Abra o Painel "Localizar/Alterar": Vá em Edit > Find/Change.2.

Selecione a Aba GREP: Certifique-se de que a aba "GREP" esteja ativa.3.

Defina a Expressão GREP para E-mails:4.

Localizar: [\\w\\.\\-]+@([\\w\\-]+\\.)+[\\w\\-]{2,4}

Explicação: Esta expressão é um pouco mais complexa, mas basicamente busca por sequências de letras, 
números, pontos e hífens ([\\w\\.\\-]+), seguidas por um @, depois por um ou mais domínios (([\\w\\-]+\\.)+) 
e, finalmente, pela extensão do domínio ([\\w\\-]{2,4}).

Aplique o Estilo de Caractere: No campo "Alterar Formato" (Change Format), clique no ícone de lupa e 
selecione o estilo de caractere "Email Link" que você criou.

5.

Execute a Busca e Substituição: Clique em "Alterar Tudo" (Change All).6.

Resultado: Todos os e-mails do seu documento agora terão o estilo "Email Link" aplicado automaticamente. 
Essa técnica é um divisor de águas para a formatação de documentos complexos!



Além do Básico: Grupos e Referências no 
GREP
Até agora, vimos como o GREP pode encontrar padrões e aplicar estilos ou substituir por um texto fixo. Mas e se 
você precisar reorganizar as partes de um padrão encontrado? Por exemplo, transformar "Sobrenome, Nome" em 
"Nome Sobrenome"? Ou reformatar datas de "DD/MM/AAAA" para "AAAA-MM-DD"? Para isso, precisamos ir um 
passo além e entender os grupos de captura e as referências.

Grupos de Captura
Caixas onde o GREP "guarda" 
pedaços específicos do texto 
encontrado. Cada parte entre 
parênteses () cria uma dessas 
caixas.

Referências
$1, $2, $3... permitem "chamar" 
o conteúdo das caixas na 
substituição, correspondendo à 
ordem dos parênteses.

Reorganização
Como um mágico que 
desmembra um objeto em suas 
partes e depois o remonta em 
uma nova ordem.

Pense nos grupos de captura como caixas onde o GREP "guarda" pedaços específicos do texto que ele encontrou. 
Cada vez que você coloca uma parte da sua expressão entre parênteses (), você está criando uma dessas caixas. 
Depois, na parte de "Alterar para" (Change To), você pode "chamar" o conteúdo dessas caixas usando referências, 
que são $1, $2, $3 e assim por diante, correspondendo à ordem dos parênteses na sua expressão de busca. É 
como um mágico que desmembra um objeto em suas partes e depois o remonta em uma nova ordem.

Essa funcionalidade é incrivelmente poderosa para reestruturar dados, padronizar formatos e até mesmo corrigir 
erros de digitação complexos. Ela permite uma flexibilidade que vai muito além da simples busca e substituição de 
texto fixo, transformando o GREP em uma ferramenta de manipulação de dados em larga escala.

Exemplo Prático: Invertendo Nomes

Problema: "Silva, João" ³ "João Silva"

Localizar: (\\w+),\\s(\\w+)

Alterar para: $2 $1

O primeiro grupo captura o Sobrenome, o segundo o Nome. Na substituição, $2 vem antes de $1, 
invertendo a ordem.



Scripts: Os Robôs Pessoais do Designer
Enquanto o GREP é um mestre em encontrar e manipular padrões de texto, ele tem seus limites. E se você precisar 
automatizar uma sequência de ações que envolvem menus, painéis, exportações ou até mesmo a criação de novos 
documentos? É aí que entram os Scripts, os verdadeiros robôs pessoais do designer.

Um Script é, essencialmente, um pequeno programa de computador que executa uma série de comandos no 
InDesign (ou em outros softwares da Adobe). Pense neles como uma receita detalhada que o InDesign segue 
passo a passo, sem questionar e sem se cansar. Se você se pega fazendo a mesma sequência de cliques e 
escolhas de menu repetidamente, há uma grande chance de que um Script possa fazer isso por você, em uma 
fração do tempo e com zero erros.

Velocidade
Tarefas que levariam minutos ou horas podem ser 
concluídas em segundos.

Precisão
Elimina erros humanos causados por distração ou 
fadiga.

Consistência
Garante que a mesma sequência de ações seja 
executada exatamente da mesma forma, sempre.

Liberação de Tempo
Permite que você se concentre em aspectos mais 
criativos e estratégicos do design.

Os benefícios de usar Scripts são imensos: velocidade, precisão, consistência e liberação de tempo. É como ter um 
assistente superdotado que conhece todos os atalhos e comandos do InDesign e está sempre pronto para 
executar suas ordens complexas com um único clique. Eles são a próxima fronteira da automação para o designer 
editorial que busca máxima eficiência e qualidade.



Onde Encontrar e Como Instalar Scripts no 
InDesign
A boa notícia é que você não precisa ser um programador para aproveitar o poder dos Scripts. A comunidade de 
usuários do InDesign é vasta e generosa, e muitos desenvolvedores compartilham Scripts úteis gratuitamente ou a 
preços acessíveis. Encontrar e instalar esses pequenos programas é mais fácil do que você imagina e pode abrir 
um leque de novas possibilidades para o seu fluxo de trabalho.

Pense no InDesign como um smartphone: ele já vem com muitos aplicativos úteis, mas você pode instalar outros 
para expandir suas funcionalidades. Os Scripts são esses "aplicativos" extras que você pode adicionar para 
personalizar e otimizar sua experiência.

Onde Encontrar Scripts

Adobe Exchange: Loja oficial da Adobe com 
extensões gratuitas e pagas

Fóruns e Comunidades: InDesign Secrets, 
Scriptopedia, Adobe Community Forums

Blogs e Tutoriais: Muitos blogs oferecem Scripts 
como recursos

Tipos de Pastas

User: Scripts específicos para seu usuário 
(recomendado)

Application: Scripts para todos os usuários da 
máquina

01

Abrir o Painel Scripts
Window > Utilities > Scripts

02

Localizar a Pasta
Clique com botão direito em "User" ou "Application" > 
"Reveal in Finder/Explorer"

03

Copiar o Arquivo
Copie o arquivo do Script (.jsx, .jsxbin ou .js) para a 
pasta aberta

04

Executar o Script
Duplo clique no Script no painel para executá-lo

Dica: Em alguns casos, pode ser necessário reiniciar o InDesign para que o Script apareça no painel. É 
uma forma simples e eficaz de expandir as capacidades do seu InDesign!



Scripts em Ação: Otimizando Fluxos de 
Trabalho
Ver um Script em ação é a melhor forma de entender seu potencial. Eles são como um canivete suíço digital, com 
ferramentas para quase todas as situações. Desde organizar elementos na página até preparar arquivos para 
exportação em massa, os Scripts podem transformar a maneira como você trabalha, tornando processos 
complexos em rotinas simples e rápidas.

A beleza dos Scripts reside na sua capacidade de automatizar sequências de ações que, de outra forma, exigiriam 
dezenas de cliques e decisões manuais. Isso é especialmente relevante no contexto do Design Responsivo e 
Cross-media, onde a necessidade de adaptar layouts e gerar variantes para diferentes plataformas (impressa, e-
book, PDF interativo) é constante. Um Script pode, por exemplo, exportar seu documento em múltiplos formatos e 
tamanhos com um único comando, garantindo que seu conteúdo esteja pronto para qualquer mídia.

"Split Story"
Divide um longo texto em vários frames 
automaticamente, um para cada parágrafo ou título, 
economizando horas de cópia e colagem manual.

"Merge Text Files"
Importa vários arquivos de texto (ex: capítulos) para 
o InDesign e os encadeia em uma única história 
automaticamente.

Exportação Automatizada
Exporta todas as páginas como imagens JPG 
separadas ou gera PDFs com diferentes 
configurações com um único comando.

Organização de Camadas
Renomeia, reordena ou mescla camadas com base 
em critérios específicos, mantendo o arquivo 
organizado.

Vamos explorar alguns exemplos de Scripts úteis e como eles podem otimizar seu fluxo de trabalho. Esses são 
apenas alguns exemplos. A comunidade de Scripts do InDesign é vasta, e com certeza há um Script para quase 
qualquer tarefa repetitiva que você possa imaginar. A chave é identificar essas tarefas em seu próprio fluxo de 
trabalho e buscar a solução automatizada.



Automação e as Tendências do Design 
Editorial 2025
O design editorial está em constante evolução, e as tendências para 2025 apontam para um cenário onde a 
adaptabilidade, a acessibilidade e a sustentabilidade são pilares fundamentais. A boa notícia é que a automação 
com GREP e Scripts não é apenas uma ferramenta para otimizar o presente, mas também um motor para abraçar e 
impulsionar essas tendências, posicionando você como um designer à frente do seu tempo.

Pense na automação como o sistema nervoso central que conecta as inovações do design à sua execução prática. 
Sem ela, muitas dessas tendências seriam impraticáveis em larga escala, exigindo um esforço manual que 
inviabilizaria sua aplicação em projetos comerciais.

Design Responsivo e 
Cross-media
Como a automação ajuda: 
GREP e Scripts são essenciais 
para criar e gerenciar múltiplas 
versões de um mesmo 
conteúdo para diferentes 
plataformas (impresso, e-book, 
PDF interativo, web). Scripts 
podem automatizar a 
exportação para diversos 
formatos, reformatar texto para 
telas menores ou maiores, e 
até mesmo ajustar layouts com 
base em regras predefinidas, 
garantindo que o design seja 
adaptável e consistente em 
qualquer mídia.

Tipografia Expressiva e 
Acessibilidade
Como a automação ajuda: 
Com a ascensão das Variable 
Fonts, que permitem ajustes 
finos em peso, largura e 
inclinação, o GREP pode ser 
usado para aplicar variações 
tipográficas específicas a 
termos ou seções, criando 
hierarquia e expressividade. 
Para a acessibilidade 
(diretrizes WCAG), Scripts 
podem ser desenvolvidos para 
verificar contrastes de cores, 
garantir a correta marcação de 
elementos para leitores de tela, 
ou aplicar estilos que 
melhorem a legibilidade para 
públicos diversos, como 
pessoas com dislexia.

Sustentabilidade no 
Design Impresso
Como a automação ajuda: 
Embora pareça distante, 
Scripts podem contribuir para a 
sustentabilidade. Eles podem 
otimizar a imposição de 
páginas para reduzir o 
desperdício de papel, gerar 
relatórios sobre o uso de tintas 
ou materiais, ou até mesmo 
auxiliar na criação de layouts 
que utilizem menos recursos. A 
eficiência gerada pela 
automação também significa 
menos retrabalho e, 
consequentemente, menor 
consumo de energia e 
materiais.

O designer do futuro não é apenas um criador de belas imagens e layouts, mas um arquiteto de sistemas de 
conteúdo, capaz de usar a tecnologia para escalar sua criatividade e atender às demandas de um mundo em 
constante mudança.



Atividade Prática: Caçando E-mails com 
GREP
Chegou a hora de colocar a mão na massa e aplicar o que aprendemos sobre GREP e Estilos de Caractere. Esta 
atividade não só solidificará seu conhecimento, mas também mostrará o poder real da automação em um cenário 
prático e comum no design editorial.

Imagine que você está trabalhando em um diretório de contatos ou em um documento com muitas referências e 
precisa que todos os endereços de e-mail se destaquem visualmente, talvez com uma cor diferente e sublinhado, 
para indicar que são links clicáveis em um PDF interativo. Fazer isso manualmente seria um pesadelo. Com GREP, é 
um piscar de olhos.

Seu Desafio

Use uma expressão GREP para encontrar todos os endereços de e-mail em um texto e aplicar um estilo 
de caractere específico a eles.

01

Prepare seu Documento
Abra um documento no InDesign e crie um frame de 
texto com exemplos de e-mails:

contato@empresa.com.br

suporte.cliente@servico.net

meu.nome.sobrenome@email.org

info@website.io

usuario123@dominio.co

02

Crie um Estilo de Caractere
Window > Type & Tables > Character Styles

Crie o estilo "EmailLink" com cor azul e sublinhado ativo

03

Abra o Painel Find/Change
Edit > Find/Change (Ctrl+F ou Cmd+F)

Selecione a aba GREP

04

Defina a Expressão GREP
No campo "Localizar (GREP)": [\\w\\.\\-]+@([\\w\\-]+\\.)+
[\\w\\-]{2,4}

Teste com "Localizar Próximo" para verificar

05

Aplique o Estilo
Em "Alterar Formato", selecione o estilo "EmailLink"

06

Execute a Automação
Clique em "Alterar Tudo" (Change All)

Resultado: Observe como todos os endereços de e-mail no seu texto são instantaneamente formatados com o 
estilo "EmailLink". Essa é a prova do poder do GREP! Você acabou de economizar um tempo considerável e 
garantiu a consistência em todo o documento.



Desafios e Boas Práticas na Automação
A automação, como qualquer ferramenta poderosa, vem com seus próprios desafios e exige boas práticas para ser 
utilizada de forma eficaz. Pense em aprender a dirigir um carro potente: ele pode levá-lo muito mais rápido e longe, 
mas exige conhecimento, prática e respeito às regras para evitar acidentes. Da mesma forma, GREP e Scripts 
podem acelerar seu trabalho, mas um uso descuidado pode gerar resultados inesperados ou até mesmo danificar 
seu documento.

É importante encarar a automação não como uma solução mágica para todos os problemas, mas como uma 
habilidade a ser desenvolvida. A curva de aprendizado pode parecer íngreme no início, especialmente com 
expressões GREP complexas ou a instalação de Scripts, mas os benefícios a longo prazo superam em muito o 
investimento inicial de tempo e esforço.

Desafios Comuns

Curva de Aprendizado: A sintaxe do GREP e o 
funcionamento dos Scripts podem ser 
intimidadores para iniciantes

Expressões Complexas: Criar expressões GREP 
muito elaboradas pode ser difícil e propenso a 
erros lógicos

Dependência de Scripts Externos: Usar Scripts de 
terceiros pode gerar dependência

Resultados Inesperados: Uma expressão GREP 
mal formulada pode alterar partes não intencionais 
do texto

Boas Práticas

Comece Pequeno: Não tente resolver o problema 
mais complexo de uma vez

Teste Sempre: Use "Localizar Próximo" para 
verificar o comportamento

Documente: Mantenha um arquivo com suas 
expressões e Scripts

Use Grupos com Sabedoria: Grupos de captura 
são poderosos, mas podem complicar a leitura

Explore a Comunidade: Busque ajuda em fóruns e 
blogs

Faça Backups: Sempre faça backup antes de 
automações em larga escala

Lembre-se: Dominar a automação é um processo contínuo de aprendizado e experimentação. Com 
paciência e as boas práticas, você transformará o InDesign em uma máquina de produtividade, elevando a 
qualidade e a eficiência do seu trabalho a um novo patamar.



Consolidação e Próximos Passos
Chegamos ao fim de nossa jornada pela automação no design editorial. Vimos como o GREP atua como um 
detetive de padrões, capaz de encontrar e manipular texto com uma precisão cirúrgica, transformando a limpeza e 
a formatação de documentos em tarefas rápidas e eficientes. Exploramos também o universo dos Scripts, nossos 
robôs pessoais, que automatizam sequências complexas de ações, liberando-nos para focar na criatividade e na 
estratégia do design.

Compreendemos que a automação não é um luxo, mas uma necessidade para o designer moderno, especialmente 
diante das tendências de Design Responsivo e Cross-media, Tipografia Expressiva e Acessibilidade, e 
Sustentabilidade. Ao dominar essas ferramentas, você não apenas otimiza seu fluxo de trabalho, mas também se 
posiciona como um profissional preparado para os desafios e inovações do futuro. Lembre-se: o objetivo não é 
substituir a criatividade humana, mas sim potencializá-la, delegando as tarefas repetitivas à máquina.

01

Primeiros Passos
Comece aplicando GREP para remover espaços duplos 
em seus próximos projetos

02

Experimente Estilos
Crie um estilo de caractere e use-o com GREP para 
destacar e-mails ou URLs

03

Explore Scripts
Veja os exemplos que já vêm instalados no painel de 
Scripts do InDesign

04

Construa Eficiência
Com pequenos passos, você construirá um fluxo de 
trabalho muito mais eficiente e profissional

Autoavaliação

Qual a principal função do GREP no Adobe InDesign?1.

a) Criar novas fontes variáveis.

b) Automatizar a exportação de imagens.

c) Buscar e substituir padrões de texto complexos.

d) Gerenciar camadas e objetos na página.

Qual metacaractere GREP é usado para encontrar "qualquer dígito" (0-9)?2.

a) .

b) *

c) \\d

d) \\s

Um Script no InDesign é mais adequado para qual tipo de tarefa?3.

a) Encontrar e substituir uma palavra específica.

b) Aplicar negrito a um único termo.

c) Automatizar uma sequência de ações que envolvem múltiplos menus e painéis.

d) Alterar a cor de um parágrafo.

A integração de GREP e Scripts com as tendências de Design Responsivo e Cross-media permite 
principalmente:

4.

a) Aumentar o custo de produção de materiais impressos.

b) Gerar automaticamente conteúdo criativo sem intervenção humana.

c) Adaptar layouts e exportar variantes de conteúdo para diferentes plataformas de forma eficiente.

d) Reduzir a necessidade de designers gráficos em projetos digitais.

Descreva brevemente como a automação com GREP e Scripts pode contribuir para a acessibilidade de um 
documento editorial. (Resposta esperada: 3-5 linhas)

5.



Gabarito e Recursos Adicionais
Gabarito:

1 c) Buscar e substituir padrões de 
texto complexos

2 c) \\d

3 c) Automatizar uma sequência de 
ações que envolvem múltiplos menus 
e painéis

4 c) Adaptar layouts e exportar 
variantes de conteúdo para diferentes 
plataformas de forma eficiente

Resposta da Questão 5:

A automação pode contribuir para a acessibilidade ao garantir a consistência na formatação de 
elementos (como títulos, links, listas), o que facilita a leitura por softwares de acessibilidade. GREP pode 
ser usado para aplicar estilos específicos a elementos que precisam de destaque ou marcação semântica 
(como termos técnicos ou URLs), enquanto Scripts podem verificar a conformidade com diretrizes de 
acessibilidade (WCAG), como contraste de cores ou estrutura de tags em PDFs, ou até mesmo reformatar 
texto para melhorar a legibilidade para públicos com necessidades especiais.

Próxima Aula:

Na Aula 25, mergulharemos em "Projetos Longos: Livros e Sumários Automáticos", onde a automação que 
aprendemos hoje será a base para construir documentos complexos com eficiência e precisão.

Recursos Adicionais:

InDesign Secrets GREP
Artigos e tutoriais aprofundados 
sobre GREP para usuários de 
todos os níveis.

Scriptopedia
Repositório de Scripts úteis 
para InDesign, com exemplos 
práticos e documentação.

Livro "GREP in InDesign"
Por Peter Kahrel - Referência 
completa para dominar o GREP 
no InDesign.

NOTA IMPORTANTE: As informações regulatórias/legais/técnicas desta aula estão atualizadas até 2025. 
Consulte sempre fontes oficiais para verificar alterações.


